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A

Legal notice



Copyright and trademark information relating to this product release.

Copyright © 2000–2020 SDL as part of the RWS Holdings Plc group of companies ("RWS
Group").

SDL means SDL Limited and its subsidiaries and affiliates. All intellectual property rights
contained herein are the sole and exclusive rights of SDL. All references to SDL shall mean
SDL Limited and its subsidiaries and affiliates details of which can be obtained upon written
request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including
those in copyright in the content of this website and documentation are owned by or
controlled for these purposes by SDL. Except as otherwise expressly permitted hereunder or
in accordance with copyright legislation, the content of this site, and/or the documentation
may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted
in any way without the express written permission of SDL.

MultiTerm is a registered trademark of SDL. All other trademarks are the property of their
respective owners. The names of other companies and products mentioned herein may be
the trademarks of their respective owners. Unless stated to the contrary, no association with
any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can
be found by clicking the following link: “Acknowledgments ” on page 79 .

Although RWS Group takes all reasonable measures to provide accurate and comprehensive
information about the product, this information is provided as-is and all warranties,
conditions or other terms concerning the documentation whether express or implied by
statute, common law or otherwise (including those relating to satisfactory quality and fitness
for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, RWS Group shall not be liable in contract, tort
(including negligence or breach of statutory duty) or otherwise for any loss, injury, claim
liability or damage of any kind or arising out of, or in connection with, the use or performance
of the Software Documentation even if such losses and/or damages were foreseen,
foreseeable or known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c)
loss of actual or anticipated profits, (d) loss of business revenue, (e) loss of anticipated
savings, (f) loss of business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect,
special, incidental or consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." Licensor makes no warranties, express, implied,
statutory or otherwise with respect to the Third Party Software, and expressly disclaims all
implied warranties of non-infringement, merchantability and fitness for a particular purpose.
In no event will Licensor be liable for any damages, including loss of data, lost profits,
cost of cover or other special, incidental, consequential, direct, actual, general or
indirect damages arising from the use of the Third Party Software or accompanying
materials, however caused and on any theory of liability. This limitation will apply even
if Licensor has been advised of the possibility of such damage. The parties acknowledge
that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet website references,
is subject to change without notice. Without limiting the rights under copyright, no part of
this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any
form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or
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for any purpose, without the express written permission of RWS Group.
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1

Using statical terminology
extraction



Welcome to the MultiTerm Extract Tools Guide. This guide explains the method of statistical
terminology extraction using MultiTerm Extract.

You can extract candidate terms to add to a new or existing termbase. It reduces the time
and effort involved in generating a termbase by automating the process where terms are
identified and entered into a central repository for review and approval. This is especially
useful when creating a termbase from large volumes of documents or from new information
that is constantly being updated.

Statistical extraction using MultiTerm
Extract
MultiTerm Extract uses a statistical extraction method to determine the frequency of the
appearance of candidate terms. It extracts term candidates and, for multilingual termbases,
their probable translations found in sentences, incomplete sentence fragments and strings
of code. The extracted terms are presented as a term candidate word or phrase.

After running the extraction process, MultiTerm Extract displays a term candidate list.
Following review and validation, term candidates become term lists. In the MultiTerm Extract
interface, you can quickly and easily validate terms. You can then use the multiple export
options to incorporate extracted terms into your existing MultiTerm terminology
management system. Terms can be exported to a MultiTerm termbase, MultiTerm XML
format or a tab-delimited format.

MultiTerm Extract supports all languages, including those of the Far East. If you are using
non-Western languages, you must have support for the relevant language installed on your
computer.

1 Using statical terminology extraction
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2

About MultiTerm Extract



MultiTerm Extract enables you to enhance your termbase with new entries calculated on a
statistical basis.

Statistical extraction features in
MultiTerm Extract
MultiTerm Extract uses statistical extraction to extract term candidates and, for multilingual
termbases, their probable translations and present them in a term candidate list. You can
extract terms frommonolingual or bilingual documents and from translation memories, and
then quickly and easily validate the terms.

The various export options enable you to incorporate extracted terms into existingMultiTerm
Extract termbases or to export terms to MultiTerm XML format or to tab-delimited format.
You can also check for terminology consistency between the termbase and a translated file.

MultiTerm Extract allows you to:

• Create term candidate lists from monolingual documents.

• Create bilingual term candidate lists from bilingual file formats.

• Update existing multilingual termbases by creating new translations for terms already
stored in MultiTerm.

• Analyze the quality of termbases and documents by comparing the terms found in
documents with those stored in the termbase.

• Compile bilingual dictionaries from bilingual file formats.

• Manually extract terms from the source document(s) to complement and enhance the
automatic term extraction process.

• Export extracted terms to MultiTerm, MultiTerm XML or a tab-delimited format.

Supported languages
MultiTerm Extract is fully Unicode-compliant and supports all Unicode-compliant languages.
However, to render non-Western languages successfully in MultiTerm Extract, you must
have support for the relevant language installed on your computer.

Supported file formats
MultiTerm Extract supports term extraction from a large range of file formats. The supported
file formats depend on the type of project that you are using.

The file formats supported by the monolingual term extraction can be used in a bilingual
project, but no translations are extracted. The formats can be used when you want to find
source terms but you must add your own translation for any terms that are extracted.

2 About MultiTerm Extract
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Project Supported File Types

Monolingual Term
Extraction Project

TXT - Plain text

RTF - Rich text format

Microsoft Office Word (*.doc)

HTML, HTM, JSP, ASP, ASPX

SGML, SGM, XML

Ventura (*.txt)

Adobe PageMaker (*.txt)

QuarkXPress (*.qsc, *.txg, *.ttg, *.tag)

TTX - TRADOStag file format

Adobe InDesign (*.isc) Microsoft Office PowerPoint
(*.ppt, *.pps, *.pot)

Microsoft Office Excel (*.xls, *.xlt)

Bilingual Term Extraction
Project

BILINGUAL FORMATS:

TMX - Translation memory exchange format

TMW - Translator's Workbench

Translator's Workbench

TXT format (*.txt) TTX - TRADOStag files

MONOLINGUAL FORMATS:

TXT - Plain text

RTF - Rich text format

Microsoft Office Word (*.doc)

HTML, HTM, JSP, ASP, ASPX

SGML, SGM, XML

Ventura (*.txt)

Adobe PageMaker (*.txt)

QuarkXPress (*.qsc, *.txg, *.ttg, *.tag)

Translator's Workbench RTF format (*.rtf)

Adobe InDesign (*.isc) Microsoft Office PowerPoint
(*.ppt, *.pps, *.pot)

Microsoft Office Excel (*.xls, *.xlt)

2About MultiTerm Extract
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Project Supported File Types

Dictionary Compilation
Project

TMX - Translation memory exchange format

TMW - Translator's Workbench

Translator's Workbench TXT format (*.txt)

Translator's Workbench RTF format (*.rtf)

TTX - TRADOStag files

Translation Project TMX - Translation memory exchange format

TMW - Translator's Workbench

Translator's Workbench

TXT format (*.txt)

Translator's Workbench

RTF format (*.rtf)

TTX - TRADOStag files

QA Project TMX - Translation memory exchange format

TMW - Translator's Workbench

Translator's Workbench TXT format (*.txt)

Translator's Workbench RTF format (*.rtf)

TTX - TRADOStag files

Export formats

You can export extracted terms directly to a MultiTerm termbase, a MultiTerm XML export
file or a tab-delimited text file.

Related documentation
The following documentation may be useful when working with MultiTerm Extract:

• There is a MultiTerm Extract tutorial installed with the product. The tutorial is accessible
from the Startmenu.

• There is a MultiTerm online help and a Trados Studio online help.

2 About MultiTerm Extract
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Accessing documentation

All guides are available in PDF format in the docs subfolder of your product DVD, and in the
Doc subfolder of your installation.

MultiTerm Extract is available for users of MultiTerm. Contact your RWS sales representative
for details.

2About MultiTerm Extract

7MultiTerm Extract Tools User Guide



2 About MultiTerm Extract

8 MultiTerm Extract Tools User Guide



3

Working with MultiTerm
Extract



MultiTerm Extract enables you to create projects, extract terms, import terms and validate
them.

MultiTerm Extract projects
MultiTerm Extract projects allow you to extract terms from existing files. Those terms can
then be reviewed, validated and exported to a termbase or other available formats to assist
in translation.

Project types

There are five types of project in MultiTerm Extract:

• Monolingual Term Extraction Project

• Bilingual Term Extraction Project

• Dictionary Compilation Project

• Translation Project

• QA Project

Use the New Project Wizard in MultiTerm Extract to create any of the projects.

Note:MultiTerm Extract support a wide range of file formats. These formats vary depending
on which project is created. See “Supported file formats ” on page 4.

Project Purpose

Monolingual Term
Extraction Project

Extracts terminology from a text in one language.

Bilingual Term
Extraction Project

Extracts terminology from monolingual formats. Extracts and
translates from bilingual formats.

Dictionary
Compilation Project

Extracts a dictionary from an existing translation memory file or a
bilingual file which has been translated using Translator's
Workbench.

QA Project Analyzes and allows you to improve the quality of termbases and
documents.

Translation Project Provides suggestions from existing texts and allows you to enter
translations to a termbase.

3 Working with MultiTerm Extract
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Translation projects

A Translation Project updates an existing termbase in MultiTerm by creating new
translations in one or more languages for corresponding terms already stored in the
termbase. You will need a text in a supported file format and the MultiTerm termbase.

For example, if your termbase contains English and Spanish indexes, and already has the
English term "Door", and your translated file contains the equivalent term in Spanish, the
Translation Project can update the termbase automatically with this term.

QA projects

A QA Project analyzes and improves the quality of termbases and documents by comparing
the terms found in documents with those stored in the termbase.

A QA Project allows you to:

• Monitor the usage of terms found in project files and the project termbase and their
respective translations. This allows you to check that the terms used in the document are
those that are contained in the termbase.

• Evaluate the translation quality of documents on the basis of the stored terminology.

Each QA Project provides a QA report. A QA report provides statistical information on the
terms in project files and existing terms from the MultiTerm termbase in the project.

Term extraction flow for Monolingual, Bilingual,
Dictionary and Translation projects

All MultiTerm Extract projects are created using the New Project Wizard. This procedure
varies depending on the type of project you are creating.

About this task

Displayed below is an overview of creating a Monolingual Term Extraction Project,
Bilingual Term Extraction Project, Dictionary Compilation Project or Translation Project.
Each step is explained in more detail later in this guide.

Procedure

1. Create a new MultiTerm Extract project by selecting File > New Project from the
menu bar. The New Project Wizard allows you to select the project type, add files,
customize settings and specify stopword lists. See “Creating projects ” on page 14.

2. Start the term extraction process by selecting Project > Process from the menu bar.
See “Extracting terms ” on page 28.

3. View the extracted term list in the Term window. For Translation Projects, the
translations for the source terms may be located in either in the input files or in the
MultiTerm termbase. See “Term window ” on page 32.

3Working with MultiTerm Extract
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4. In the Term properties window you can check each word, and for Translation Projects,
you can select a term and add translations.

5. Validate terms using the Concordance window for reference. See “Validating extracted
terms ” on page 39.

6. Export validated terms by selecting File > Export the menu bar and using the Export
Wizard.

See “Exporting terms in MultiTerm Extract ” on page 41.

Term extraction flow for QA projects

You can check documents and termbases using a QA Project.

3 Working with MultiTerm Extract
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Procedure

1. Create a QA Project using the New Project Wizard. See “Creating projects ” on page 14.

2. Extract the terms. See “Extracting terms ” on page 28.

3. Check the QA statistics. See “QA Statistics ” on page 74.

4. Process the files. See “Settings ” on page 66.

5. View the QA statistics. See “QA Statistics ” on page 74.

6. Export any suspect sentences if necessary and edit them. See “Exporting suspect
sentences in a QA Project ” on page 58.

7. Process the project and check the QA statistics again.

Project creation prerequisites
Ensure that all prerequisites are observed before you start creating projects. All MultiTerm
Extract projects are created using the New Project Wizard.

Ensure that you are familiar with the following information:

• MultiTerm Server computer details - These details determine the MultiTerm Server
computer name that provides access to the termbases with which you want to work.

• MultiTerm Server connection type - Find out whether your computer and the MultiTerm
Server computer are linked by a standard LAN or a MultiTerm Anywhere connection. A
standard LAN connection applies when both computers belong to the same physical
domain. A MultiTerm Anywhere connection applies when the two computers belong to
separate physical domains.

• MultiTerm Server login details - This information determines the user name and
password for your MultiTerm Server login.

• The name and location of the local termbase you intend to use in your project. Know
the name and location before you open the New Project Wizard. You have exclusive
access and unlimited user rights in all local termbases, and no login details are required.
Contact your MultiTerm administrator for these details and for information about your
termbase user rights. You must have sufficient rights to work with a remote termbase
from MultiTerm Extract.

Note:When you connect to a MultiTerm Server, the license restrictions as defined on the
server are applied, so you might not be able to open the termbase because no free viewing
seats are available on the server. In this case, wait until an appropriate seat becomes
available and inform your MultiTerm administrator.

3Working with MultiTerm Extract
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Creating projects
All MultiTerm Extract projects are created using the New Project Wizard.

Before you begin

Ensure that all “prerequisites ” on page 13 are observed.

About this task

The example shows you how to create all of the different project types in MultiTerm Extract.
The procedure for creating a Monolingual Term Extraction Project, Bilingual Term
Extraction Project and Dictionary Compilation Project is similar.

Note: If you are extracting terms from HTML, SGML, XML, ASP or JSP formats, see “File
format settings ” on page 72.

Procedure

1. Select File > New Project from the menu bar.

2. In the New Project Wizard, consult the Choose project type, name and location page.

3. Select your project type:

• Monolingual Term Extraction Project - It contains extracted terms from one or
more single-language texts.

• Bilingual Term Extraction Project - It contains extracted source and target terms
from bilingual files (TTX, TMW, TMX). You can also use WinAlign export files and add

3 Working with MultiTerm Extract
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monolingual files to bilingual term extraction projects.

• Translation Project - It is used to update an existing MultiTerm termbase by offering
new translations for terms already stored in the termbase and by adding new term
pairs.

• QA Project - It helps you monitor the use of terms in a document and a termbase,
and the way they are translated. It allows you to evaluate the translation quality of
documents and termbases.

• Dictionary Compilation Project - It contains an alphabetically-sorted dictionary
compiled from bilingual files (TTX, TMW, TMX). It includes source language terms as
well as their target language translations.

4. Complete the following information:

a. Enter a name for the project in the Project Name box.

b. Select Browse to select a location for the MultiTerm Extract project. By default
MultiTerm Extract places all projects in a Projects folder within the MultiTerm Extract
installation folder.

5. Select Next, and then, on the Choose termbase and languages page, select the project
languages and optionally, a project termbase.

Selecting a project termbase enables you to perform the following actions:

• You can exclude the terms in the termbase, from the extraction process. This means
that known terms are ignored by MultiTerm Extract.

• You can export the terms from your project into the project termbase, when the
project is created and the terms have been extracted and validated. See “Exporting
terms in MultiTerm Extract ” on page 41.

3Working with MultiTerm Extract
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6. If you do not want to add a termbase to your project, select No Termbase and then
complete the Source Language and Target Language boxes by selecting the project
source and target languages. Only the languages supported by your operating system
are available for selection. The Target Language box is not displayed if you are creating
a monolingual project. Now go to step 8.

Note: All Translation Projects and QA Projectsmust have a termbase in the project.
For this reason, the No Termbase option for these projects is not available.

7. If you want to add a termbase to your project, select Termbase and select Choose. In
the Choose Termbase dialog, consult the list of the termbases you have used previously.

• To use a server termbase, select the termbase and select OK. If the termbase is
server-based, the Connect to MultiTerm Server dialog is displayed. Enter your login
name and password for the server and select OK. Go to step 7.

• To use a local termbase that is not in the list, select Browse termbase. In the Open
Termbase dialog, navigate to the required termbase, select the termbase and select
Open. The termbase is added to the Termbases box. Select the termbase and
select OK. Go to step 8.

• To use a server-based termbase that is not in the list, select Remote login. The
Login to MultiTerm Server dialog is displayed.

3 Working with MultiTerm Extract
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Note:MultiTerm server login details are available from your MultiTerm
administrator. If you intend to export terminology directly to the remote termbase,
make sure that the login you receive provides you with sufficient termbase access
rights.

• Enter the name of theMultiTerm Server computer.

• Select Standard LAN orMultiTerm Anywhere, depending on the type of connection
that exists between your computer and the MultiTerm Server computer. If both
computers belong to the same physical domain, choose Standard LAN. This is the

3Working with MultiTerm Extract
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connection that is generally used. If both computers belong to separate physical
domains, chooseMultiTerm Anywhere.

• If you selectedMultiTerm Anywhere and your organization uses a proxy server,
select Use proxy server within your LAN and complete the Address and Port
boxes.

• Select OK to save the server connection details and close the Connect to MultiTerm
Server dialog box. If the login details you provided were correct, the termbases
available on the server are added to the list in the Choose Termbase dialog box.

• Select the required termbase from the list and clickOK to close the Choose Termbase
dialog box.

Note: You only need to define the remote termbase connection settings for your
project once. Thereafter, each time you open the project, the Connect to MultiTerm
Server dialog box is automatically displayed enabling you to log in and access the
relevant termbase in a more direct fashion.

8. Under Termbase, complete the Source Language and Target Language boxes by
selecting the project source and target languages. Only the languages supported by
your operating system are available for selection. The Target Language box is not
displayed if you are creating a monolingual project.

9. Select Next, and on the Add files to this project page is displayed, select the files to be
searched for potential terminology. Select Browse to open the Add dialog. Browse to
the location of the files you want to add to the project. Select a file or a group of files and
select OK. The selected file or files are added to the Project Files list. Continue adding
files until the list is complete.
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• To specify a settings file (*.ini) for the files you have selected, select File Format
Settings. See “File format settings ” on page 72.

• To create the project using the default settings, select Finish.

• To change the default settings before creating the project, go to step 10.

10. Select Next. The Excluded terms page is displayed. Use this page to define the exclusion
and learning settings for your project. This page is not displayed for Translation
Projects andQA Projects. Exclusion Settings - during the extraction process, MultiTerm
Extract ignores any terms that already exist in the termbase and/or file that is specified
under Exclusion Settings. Learning Settings - during the extraction process, MultiTerm
Extract records any terms that you manually reject in a dedicated database. MultiTerm
Extract learns to automatically ignore these unwanted terms as extraction continues.

11. Specify Exclusion Settings:

a. Select Exclude termbase.
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b. In the Choose Exclude Termbase dialog, select the termbase whose terms you want
to exclude from the term extraction process.

• To select an already known termbase, select the termbase in the list and select
OK. The Choose Index to Exclude dialog is displayed.

• To select a local termbase, select the Browse termbase button.

• To select a remote termbase, select Remote Login to open the Server Login
dialog. For more information about termbase connection settings, go to step 6.
After returning to the Choose Exclude Termbase dialog box, select the termbase
and click OK. The Choose Index to Exclude dialog box is displayed.

Note: If you selected a project termbase already in step 5, this is automatically
displayed under Exclusion Settings.

c. Complete the Choose Languages to Exclude dialog box.
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d. Select the source index to which MultiTerm Extract should refer when checking for
terms to exclude from the term extraction process.

e. Click OK to return to the Excluded terms page.

f. On the Excluded terms page of the New Project Wizard, click Exclude file to specify
lists of terms you do not want to include in the extraction process. The Select dialog
box is displayed.

g. Browse to the exclude list and choose the list. MultiTerm Extract comes with basic
vocabulary lists for certain European languages. If there is a basic vocabulary list
available for your source language, this is automatically displayed.

h. Click Select to return to the Excluded terms page.

12. Specify Learning Settings

a. On the Excluded terms page of the New Project Wizard, select the Record discarded
terms check box to choose a learning database.
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b. Click Browse to select the database or to create a new one and the Choose Learning
Termbase is displayed.

c. If you want to select a remote termbase, click Remote Login to open the Server
Login dialog box. For more information about termbase connection settings, go to
step 6.

d. If you want to select a local termbase, Click the Browse tembase button.

e. To create a new termbase, click New termbase and the Create Learning Termbase
dialog box is displayed. Enter a Termbase name and select the termbase languages.
Click Create and OK to return to the Excluded terms page.

13. Click Next. Depending on the type of project you are creating, one of three pages is
displayed. Use these pages to customize the MultiTerm Extract settings.

• ForMonolingual Term Extraction Projects and Bilingual Term Extraction
Projects, go to step 11.

• For Translation Projects and QA Projects, go to step 12.

• For Dictionary Compilation Projects, go to step 13.

14. ForMonolingual Term Extraction Projects and Bilingual Term Extraction Projects,
the Term extraction settings page is displayed. Use this page to customize the MultiTerm
Extract term extraction settings:
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a. In theMinimum term length box, specify the minimum number of words required
to form a term candidate. The default setting is 1.

b. In theMaximum term length box, specify the maximum number of words that a
term candidate may have. The default setting is 10.

c. SelectMaximum number of extracted terms to set the maximum number of term
candidates that MultiTerm Extract will extract. The default setting is 100.

d. Set the Silence/noise ration. The higher the silence ratio, the fewer term candidates
are extracted. However, these term candidates are generally of a higher quality.
The higher the noise ratio, the more term candidates are extracted. However, it is
likely that these will include a number of lower quality candidates.

e. Select Stopword Lists to set the language-specific list(s) containing articles,
pronouns and other items that are to be excluded from the extraction process.
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15. For Translation Projects and QA Projects, the Term Recognition Options page is
displayed. The options available are different depending on if a Translation Project or
QA Project was selected. Use these pages to customize the MultiTerm Extract term
recognition settings. The following page is the Term Recognition Options for a
Translation Project.

a. Select Only show terms in project termbase that are found in documents to
only include terms from the termbase that are displayed in the project file
(Translation Projects only).

b. Select Show all terms in project termbase to include all terms in the project
termbase (Translation Projects only).

c. The following page displays the Term Recognition Options for a QA Project. The
options available on this page are relevant to both Translation Projects and QA
Projects.

d. Use theMinimumMatch Value % box to specify a value below which terms will not
be included in the project.

e. Use the Search-Depth (10-999) box to specify the number of terms to search at a
time. When scanning source segments for terminology, MultiTerm Extract evaluates
not only single words but also multiple word units, trying to find similar terms in
the current termbase. The search depth value defines the number of fuzzy matches
MultiTerm Extract should return. Increasing the Search-Depth value slows down
terminology recognition. You can set it to any value between 10 and 999; however,
high values are only necessary if you are working with large terminology databases.
The default Search-Depth setting is 20 (matches) and in most cases this should
produce satisfactory results.

16. For Dictionary Compilation Projects, the Dictionary compilation settings page is
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displayed. Use this page to customize the MultiTerm Extract dictionary compilation
settings:

a. In theMinimum word frequency box, specify the minimum number of times a
term and its translation must be shown in a text before being added to the term
candidate list. The default setting is 3.

b. Select theMaximum word frequency checkbox to specify the maximum number
of times a term and its translation can be shown in a text before being excluded from
the term candidate list. The default setting is 20.

c. Select theMaximum number of translations checkbox to specify the maximum
number of possible translations that MultiTerm Extract will extract for a given term.
This option is active by default and the default setting is 5.

d. In theMinimum translation frequency box, specify the minimum number of
times a term must be translated by its target term in order for the target term to be
added to the term candidate list. The default setting is 3.

e. Select theMaximum translation frequency checkbox to specify the maximum
number of times a term may be translated by its target term before the target term
is excluded from the term candidate list. The default setting is 20.

f. Select Stopword Lists to select the language-specific list(s) containing articles,
pronouns and other items that are to be excluded from the extraction process.

17. Select Next. For Bilingual Term Extraction Projects and Translation Projects, the
Translation settings page is displayed. Use this page to customize the MultiTerm Extract
translation settings.
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a. Select the Search for new translations checkbox to enable MultiTerm Extract to
extract translations and to specify the Translation Options.

b. Select theMaximum number of translations checkbox to set the maximum
number of possible translations that MultiTerm Extract will extract for a given term.
By default, this checkbox is selected and the default setting is 5.

c. In theMinimum translation frequency box, specify the minimum number of
times a term must be translated by a certain target term for the target term to be
added to the term candidate list. The default setting is 3.

d. Select Stopword Lists to set the language-specific list(s) containing articles,
pronouns and other items that are to be excluded from the extraction process.

18. Select Next. The Completing the New Project Wizard page is displayed. Use this page to
review the settings you specified for the created project.
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19. Select Finish. In the MultiTerm Extract Confirm dialog:

• Select Yes to start processing the project.

• Select No to return to the MultiTerm Extract interface.

Saving a project
Once a project is created, we recommend saving changes to your MultiTerm Extract project
regularly.

There are three methods to save changes to your project:

• Select File > Save Project or File > Save Project As from the menu bar.

• Use the [Ctrl]+[S] keyboard combination.

• Select Save Project on the MultiTerm Extract file toolbar.
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Importing terms into translation
projects
You can add external terms to your MultiTerm Extract Translation Project. The process
consists of importing terms from a text file.

Procedure

1. Select Import from the Filemenu.

2. In the Import dialog, specify the name and location of the file from which you want to
import terms in the Import file box, or select Browse to locate the file.

3. Specify the type of encoding in the file from the Encoding drop-down list. The available
encoding depends on the source language selected for the project. For example, you
may have a choice of ANSI, Unicode or UTF8 text.

4. Select OK to begin the import.

5. Consult the progress bar in the Import dialog. When the import process is complete,
select OK to return to MultiTerm Extract.

Extracting terms
After a project is created, the next step is to extract the terms from the files you added
during the project creation. Those terms are then added to a candidate term list in the
project, for review and validation. Terms can be automatically or manually extracted from
your project files.

Extracting terms automatically

There are two ways of starting the automatic term extraction process:

• MultiTerm Extract prompts you to start the process after you add files to a project.

• Select Project > Process from the menu bar. You can also press [F7].

Note: The Process option is enabled after you create a new, or open an existing, MultiTerm
Extract project. The option is unavailable if no MultiTerm Extract project is open or if no
files have been added to the project.
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The Term Extraction dialog is displayed. A progress bar indicates the completion of the
extraction process. The displayed actions performed, for example, Translating terms and
Gathering QA statistics vary depending on the chosen project type.

Once the progress bar has reached 100%, select OK to view the extracted terms in MultiTerm
Extract.

Extracting terms manually

About this task

MultiTerm Extract allows you to add more terms to the term candidate list by manually
extracting terms from a document.

Procedure

1. Open your MultiTerm Extract project and select the source and target languages.

2. Select Project > Settings from the menu bar to open the Project Settings dialog.

3. On the Add/Remove Files tab, select Browse to add the files from which to extract
terms.

4. Select OK to close the dialog.

5. Select View > Text Windows from the menu bar and select the document to display.
The document opens in a text window, as shown below.
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6. Newly extracted terms and translations are formatted in red text by default. Existing
terms and translations are formatted by default in green text by default. MultiTerm
Extract assigns a line number to each sentence in the file. To add terms manually, select
the text to add and do one of the following:

• Select the text in the text window and select Add term or translation on the
toolbar.

• Press the keyboard shortcut [Ctrl]+[Insert].

Add term pairs by first selecting the source term. Next, right-click and choose Add
as New Term from the context menu. Alternatively, select Add term or translation
on the toolbar. Select the corresponding translation, right-click and choose Add as
Translation from the context menu. Alternatively, select Add term or translation
again on the toolbar.

Text window

There are a number of options available in the text window toolbar:

• Navigation: Use Next page, Previous page, First page, Last page to scroll
through the pages of the document in the text window.

• Concordance: Select Show concordance to display further concordance matches for
the term candidate in the Concordance window.

• Term properties: Select Show term properties to display the term candidate in the
Term properties window.
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• Go to: Select Go to sentence to locate a specific sentence number by entering a
number into the Go to sentence dialog.

• Add terms by selecting the term, right-clicking and choosing Add as New Term from
the context menu or by selecting Add term or translation.

• Remove terms by selecting the term, right-clicking and choosing Delete Term from the
context menu, by selecting Delete term or translation or by pressing [Delete].

• The Show/Hide flag displays or hides the corresponding source and/or target
language flags.

• Use Undo and Redo to undo or redo your most recent action.

• Select Help to open the online Help for MultiTerm Extract.

MultiTerm Extract Interface
This section describes how MultiTerm Extract terms are displayed for viewing and validation.

The interface is divided into four parts:

• Menu and toolbars - Located at the top of the interface.

• Term window - Displays the extracted terms in spreadsheet format. If the project is a
bilingual project the Term window also contains a list of translated terms.

• Term properties window - Displays additional information about a selected term and
allows you to carry out global operations on the list of extracted terms.

• Concordance window - Displays the terms in context.
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The next section explains how to use the Term, Term properties and Concordance windows
to review and validate terms before exporting them.

Term window

Extracted terms are displayed in the Term window.

The Term window contains a list of all the terms that MultiTerm Extract has extracted in the
current project. The spreadsheet presentation includes the following information about each
term:

• Filter - It displays the active filter.

• Find - It is used to search for candidate terms among the source terms in the Term
window. This is not case-sensitive. After entering the text and viewing the results, you
can return to the term list in the Term Window by deleting the string and pressing
[Enter].

• Score - It displays the score that MultiTerm Extract assigns to a term during the
extraction process. The score is largely calculated using the frequency with which a
term appears in the document. High scores indicate probable terms. This column is not
available in the Translation Projects and Dictionary Compilation Projects.

• Domain - It shows the term category. You can change the domain in the Term window
in the following ways:

• For a selected term, right-click the selected term and choose a domain label from
the Set Domain submenu on the context menu. Alternatively, double-click the
Domain column and choose a domain label from the drop-down list.

• For several terms, select several terms at once by pressing [Ctrl]+[Shift] and
selecting the relevant terms. Right-click any of the selected terms and choose a
domain label from the Set Domain submenu on the context menu.

Select Settings in the Term properties window to display the Term Properties Window
Options dialog. Use this dialog to define the domain labels for your project. Once you
have added a domain label there, it becomes automatically available from the Domain
column in the Term window. See “Term Properties Window” on page 33. If the Domain
column is hidden, right-click in the spreadsheet area or in the title bar of the Term
window and select Show Domain. To hide it again, right-click in the spreadsheet area or
in the spreadsheet header and select Hide Domain.

• Source Language Term - MultiTerm Extract lists the extracted source language terms
under the source language. If the source language term check box is selected, it indicates
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it is a validated term. When you first run the extraction process, none of the terms are
validated.

• Translations - The translation(s) for the extracted term. MultiTerm Extract lists
translations under the target language. Translations also require validation. You can
add a translation in the Term window by right-clicking and selecting Add Translation
from the shortcut menu or by pressing [Ctrl]+[Insert], but this is only possible when no
Filter is active.

Note: If an acronym is found, the text is placed in the corresponding box in the Term
properties window. The definition or long form of the acronym is displayed in the window.

Sorting Terms

The default sort order for terms is by Score which lists terms starting with the most probable
terms. You can also sort terms by domain or source language by clicking on the column
label. A gray arrow indicates the current sort order.

Deleting Terms

To delete terms in the Term window, click to select the term to delete, right-click and choose
Delete from the shortcut menu or press [Delete]. The term is removed from the term
candidate list.

Term Properties window

The Term properties window is divided into four areas:

• Global operation buttons

• Term and translation information

• Definition box and Note box
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• Context information

Global operation buttons

• Select Go to first term, Go to last term, Go to previous term and Go to
next term to scroll through the extracted terms and view their properties.

• Select New term to add a new term to the extracted list.

• Select Remove entry to remove the currently selected entry from the MultiTerm
Extract project.

• Select Concordance to display concordance information about a term

• Select Settings to display the Term Properties Window Options dialog. You can create
new domains, specify the default domain and select which boxes are displayed in the
Term properties window.

Term and translation information

This area displays general information about the selected term and its translations.

• Source Language Term: The source language term candidate as extracted by MultiTerm
Extract. The language is shown with a flag. Checked boxes indicate validated terms. If
you have run the extraction process for the first time none of the terms will be validated.

• Translation: The target language is shown with a flag. You can validate a candidate
translation by selecting the check box before the translation, or enter a new translation.
To enter a new translation, select the Click here to enter a new translation checkbox
and start typing. To delete a translation, select the term in the Translation box of the
Term properties window and press [Delete]. Alternatively, select the term in the Term
window and click Delete.

• Domain: This shows the term category. You can specify the domain for a selected term
by choosing the domain from the drop-down list in the Domain box. Alternatively, you
can click in the Domain box and enter a new domain label. The new label is added to
the list of available domains.

• Synonyms: You can store synonyms of the term in this box. For example, you could
enter lecture, discourse or oration.

• Acronym: You can store any acronym associated with the source term in this box.

• Word forms: Displays the word forms for the source term as found during term
extraction. This box is read-only.

• Filename: Displays the name of the file(s) from which the source term was extracted.
This box is read-only.

• Created: The date and time that the term was created. This information is displayed in
the status bar.

• Modified: The date and time that the term was modified. This information is displayed
in the status bar.

Note:When you perform an export, only the term and not the word forms are exported.
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Definition box

Add a definition of the term in the Definition box.

Note box

Add any comments about a term or its translation(s) in the Note box.

Context information

The Context sentences box stores sentence(s) showing the term in context.

• Select Add new sentence to enter a sentence that shows the term in context. Enter the
sentence in the Context sentences box. The corresponding flags for each language
are displayed before each sentence. Alternatively, you can right-click a sentence in the
Concordance window and select Add As Context Sentence from the context menu.

• Select Remove sentence to delete context sentences that are not suitable.

• Select Generate sentences to generate context sentences for a selected term or all
terms. The default number of context sentences is five. Review and edit the displayed
context sentences.

When you export terms, you can attach context sentences to each exported term as well as
the name of the file from which the sentence was extracted.

Note: By default, terms and translations that were validated and exported from the project
during previous edit sessions are formatted in green. You cannot edit these terms and
translations.

Concordance window

The Concordance window displays the extracted terms in context.
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There are several ways of displaying a term in the Concordance window:

• In the Concordance window, highlight the term in the Term window and press [Enter]
to display it.

• In the Concordance window, enter the term in the term box and either press [Enter] or
select Search. MultiTerm Extract locates the term and displays it in the Concordance
window.

• In the Term and Text windows, select a term, right-click and choose Concordance from
the context menu.

• In the Term properties window, select Concordance.

Note: You can also select a term or place the cursor on it in the text window and press [F3]
or select Show concordance.

If there is more than one concordance hit shown in the Concordance window, you can move
from term to term using the following keyboard shortcuts:

• Place the cursor on a term. The text changes to a blue color.

• Press [Tab] to go to the next occurrence of the term in the Concordance window.

• Press [Shift]+[Tab] to return to the previous occurrence of the term in the Concordance
window.

3 Working with MultiTerm Extract

36 MultiTerm Extract Tools User Guide



Word forms and translations are displayed in context, that is, within a sentence. This is a
sentence from the file from which they were extracted. The word form or translation is
highlighted in the text using a different color, size or font, depending on the settings that
you selected in the Format dialog. You can access the Format dialog by selecting Tools >
Format from the menu bar. The selected term is displayed in blue. If you are working with a
Monolingual Term Extraction Project, only the source language box is displayed.

Adding or deleting terms in the Concordance window

• To add a new term or translation from the Concordance window, select a term, right-click
and choose Add as New Term or Add as Translation from the context menu or press
[Ctrl]+[Insert]. The term is displayed on the term candidate list immediately and is
assigned a term score of 100.

• To delete a term or translation from the Concordance window, right-click and choose
Delete Term if it is a source language term or Delete Translation if it is a target
language translation from the context menu or press [Delete]. The term is removed
from the term candidate list.

Formatting terms in the Concordance window

In the Concordance window, the default formatting for the text is Arial 12 point and Arial 12
point red for the highlighted word form or translation. You can modify the way text and
terms are displayed in the Concordance window.

Procedure

1. Select Tools > Format from the menu bar. The Format dialog is displayed.
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• When the Text category is selected, the Preview pane shows how text will be
displayed in the Text window that is used for manual term extraction and in the
Term, Term properties and Concordance windows.

• When the Concordance highlighting category is selected, the Preview pane shows
how matching terms will be displayed in the text window that is used for manual
term extraction and in the Concordance window.

• When the Existing Terms category is selected, the Preview pane shows how existing
terms will be displayed in the Term, Term properties and Concordance windows.

2. Select Change to open the Choose Font dialog.
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3. Select the Font, Font Colour, Size and Background Colour. Select OK to preview the
font in the Format dialog.

4. Select OK to apply the changes and to return to MultiTerm Extract.

Repeat this process for each language in your MultiTerm Extract Project.

Validating extracted terms
To ensure that the extracted terms are accurate and appropriate, validate them.

Procedure

1. Review the term candidates in the Term window.
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2. Manage the terms by deleting or validating them:

• Select a term and press the space bar.

• Select the checkbox corresponding to the term you want to validate.

• Right-click the term and select Validate from the context menu. Use the down
arrow to scroll through the term candidate list.

3. After you review all term candidates in the Termwindow, use the Term properties window
to examine terms in more detail. You can add new terms and remove term candidates
that are not useful. In the Term window, select a term to display it in the Term properties
window.

4. Review the term and its translations, using the Generate sentences button to refer to
concordance sentences where necessary. Make any modifications required to the term
properties.

5. Select Next term to display the next term in the list. Repeat steps 2 and 3.

6. Continue until you have reviewed and validated all the terms in the MultiTerm Extract
project.

Note: You can validate all term candidates by right-clicking in the Term window and
selecting Validate All from the context menu. Alternatively, to start the term review
again, select Invalidate All to invalidate all term candidates.
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4

Exporting terms in MultiTerm
Extract



After your extracted terms have been validated in MultiTerm Extract, they can be exported
using the Export Wizard.

This wizard takes through the process of exporting extracted terms from your MultiTerm
Extract project. You can export to a:

• Project Termbase

• MultiTerm Termbase

• MultiTerm XML Format

• Tab-deliminated Text Format

Note: If you are exporting to MultiTerm export format, MultiTerm Extract allows you to add
extracted terms to your existing termbase. You can also exclude terms from being added to
your existing termbase by the term extraction process. You should close your termbase
before starting the export.

Export definitions
During the export process an export definition file is used containing information such as
the export type and file format.

When exporting you can use an existing export definition file or create a new one. MultiTerm
is the default export type when creating a new export definition file.

Prerequisites for term export
Before you can export terminology correctly and accurately, you must be familiar with
various information items.

If you intend to export data directly to a remote MultiTerm termbase, the following
information is required to define termbase connection settings:

• MultiTerm Server computer details - These details determine the name of the MultiTerm
Server computer that provides access to the termbases with which you want to work.

• MultiTerm Server logon details - These details determine the user name and password
of your MultiTerm Server login.

Contact your MultiTerm administrator for these details and for information about your
termbase user rights. You must have write permission in the appropriate areas of the
specified remote termbase to export data directly from MultiTerm Extract. If you intend to
export directly into a local termbase, determine the name and location before you start the
Export Wizard. You have exclusive access and unlimited user rights in all local termbases,
and no login details are required.
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Exporting terms
You can export extracted terms from MultiTerm Extract to integrate them in your termbases.

Before you begin

Ensure that all “prerequisites for term export ” on page 42 are observed.

Procedure

1. Access File > Export from the menu bar.

2. In the Export Wizard, select Next, and, on the Export Definition page, select the export
type:
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• To export to a project termbase, select Export to the project termbase.

• To export to a MultiTerm termbase, select Create a new export definition and
selectMultiTerm Termbase from the drop-down list.

• To export to MultiTerm XML format, select Create a new export definition and
selectMultiTerm XML Format.

• To export to tab-delimited text format, select Create a new export definition and
select Tab delimited from the drop-down list.

• To export using an existing export definition, select Export using an existing export
definition. See “Exporting using export definitions ” on page 52.

3. Select Next. On the Export Settings page choose an options. The options are different
depending on which type of export you selected. Use this page to define the export
settings.

• To export to a project termbase, go to step 7.

• To export to a MultiTerm termbase, go to step 4.

• To export to MultiTerm XML format, go to step 5.

• To export to tab-delimited text format, go to step 6.

4. If you selected to export to a MultiTerm termbase, the following page is displayed.
Select Export to termbase, and then select Browse to locate the termbase.
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Note: You may be required to reconnect to the termbase. If this happens, you must
log on again.

5. If you selected to export to MultiTerm XML format, the following page is displayed.

a. Select the Export File Location. By default, MultiTerm Extract selects the current
projects folder and creates an XML file (*.xml) with the same name as the project
name.

b. Specify a Termbase or termbase definition File (*.xdt). The selected item provides
MultiTerm Extract with the termbase definition reference that is required to create
the export file.
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6. If you selected to export to tab-delimited text format, the following page is displayed.
Select Export File Location. By default, MultiTerm Extract selects the current projects
folder and creates a text file (*.txt) with the same name as the project name.
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7. Select Next. On the Filters page, select or create a new filter. You can select a filter from
the drop-down list. MultiTerm Extract ships with two predefined filter definitions: Only
Validated and Only Non Validated terms. The default setting is No Filter.

Note: Select Create New Filter to create a new filter or select Edit Filter to edit an
existing filter. See “Using filters when exporting ” on page 59.

8. Select Next. The Export Languages page is displayed. Use this page to select the
languages you want to export.

• This page is not displayed if you selected to export to tab-delimited text format, go
to step 13.

• On the Export Languages page, map the languages in your MultiTerm Extract project
to the corresponding language in the MultiTerm termbase, project termbase or
MultiTerm XML format. Select a MultiTerm language from the drop-down list for each
language.

9. Select Advanced. The Export Schema dialog is displayed. Use this page to create an
export schema.
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MultiTerm Extract automatically exports source and target terms to the termbase. If
you create an export schema, you can also export the following information to the
selected termbase: Domain, Definition and Note boxes. For source and/or target
languages you can export Validation status information (Validated), Score, Context
(and if required, context sentences and context sentence file name), File name,
Acronym,Modified and Created boxes.
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10. In the Exported Field box, select a checkbox to export information for that item. For
example, select Context to export Context information. The boxes pertaining to that
selected checkbox are displayed on the right side of the dialog.

• In the Level box, select a level from the drop-down list to indicate which level the
term is to be exported to the termbase. Each box should be associated with a level
in MultiTerm, for example, Entry level fields, Language level fields and Term level
fields.

• Select the Field in the MultiTerm termbase to which to export Context from the
drop-down list. MultiTerm Extract displays the MultiTerm termbase fields in a
drop-down list.

• Select Automatically generate context sentences to add context information to
the termbase. The default setting for this option is 10 sentences. If you want to
change the number of sentences, enter a different number

• Select Export context sentence filename to export this information.

11. Select OK to return to the Export Wizard.

12. Select Next. The Termbase Export Options page is displayed. Use this page to select
different export options.

Note: This page is only displayed for exporting to a MultiTerm termbase or project
termbase. For all other projects, go to step 13.
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• Select Export all terms as new entries if each term is to create a new entry. You
can choose between Export al ltranslations to one new entry, if all translations are
to be exported under the same entry or Export each translation to a separate
new entry, if each translation of a given source term is to be exported under a
different entry.

• Select Update existing concepts and merge on source language term if all
termbase entries which have the same index term are to be merged and updated
with newly exported information.

• Select Prompt for each term to determine how each term is exported

13. Select Next. The Completing the Export Wizard page is displayed. Use this page to
review a summary of the options you selected for this export. Select Finish to start the
export process.
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14. MultiTerm Extract prompts you to save the export definition for future use. Select Yes if
you want to save the export definition for re-use. For more information, see “Exporting
using export definitions ” on page 52.

15. In the Choose Export Definition dialog, enter the file name for the export definition and
select Set.
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16. If you are exporting to a remote termbase, a message is displayed asking you to specify
the termbase entry class to which data will be exported. Select the entry class from
the drop-down list.

Note: You must have write permission for the specified termbase entry class to export
data directly from MultiTerm Extract. If necessary, contact your MultiTerm administrator
for precise details of your termbase user rights.

17. In the Export dialog, a progress bar indicates the export status. When the progress bar
reaches 100%, select OK to exit the Export Wizard and return to MultiTerm Extract.

Exporting using export definitions
An export definition file defines the export type and file format for export.

The options displayed during the Export Wizard vary depending on which export definition
file is selected. You can use an existing export definition file or create a new export definition
file when exporting.
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Exporting using an existing export definition

You can export extracted terms from MultiTerm Extract using an existing export definition.

Procedure

1. Access File > Export from the menu bar.

2. On the Export Wizard, select Next, and on the Export Definition page, select the export
type.
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3. Select Export using an existing export definition and select Browse to select
MultiTerm Extract export definition file (*.exd). Select Set.

4. The Export Wizard guides you through the steps required for the chosen export
definition.

5. When you reach the final page in the wizard, Completing the Export Wizard, select
Finish to start the export process and to close the Export Wizard.
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Exporting using a new export definition

You can export extracted terms from MultiTerm Extract using a new export definition file.

Procedure

1. Access File > Export from the menu bar.

4Exporting terms in MultiTerm Extract

55MultiTerm Extract Tools User Guide



2. In the Export Wizard, select Next, and on the Export Definition page, select the export
type.
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3. Select Create a new export definition and select the export type from the drop-down
list.

4. Select Next. The Export Wizard guides you through the steps required for the new
export definition. Options vary depending on which export format is selected. See
“Exporting terms ” on page 43.

5. When you reach the final page in the wizard, Completing the Export Wizard, select
Finish to start the export process and to close the Export Wizard.

6. MultiTerm Extract prompts you to save the export definition for future use. Select Yes to
save the export definition for re-use.

7. In the Choose Export Definition dialog, enter the file name for the export definition and
select Set.
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8. If you are exporting to a remote termbase, a message is displayed asking you to specify
the termbase entry class to which data will be exported. Select the entry class from
the drop-down list.

Note: You must have write permission for the specified termbase entry class to export
data directly from MultiTerm Extract. If necessary, contact your MultiTerm administrator
for precise details of your termbase user rights.

9. In the Export dialog, a progress bar indicates the export status. When the progress bar
reaches 100%, select OK to exit the Export Wizard and return to MultiTerm Extract.

Exporting suspect sentences in a QA
project
You can export suspect sentences from a file. This procedure can only be performed in a QA
Project. Suspect sentences are sentences that contain terminology that does not match a
translation in the termbase. Exporting suspect sentences allows you to edit them as a group.
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Procedure

1. Access File > Export Suspect Sentences from the menu bar or press [Ctrl]+[E].

.

2. In the Export Suspect Sentences dialog, select the file from which you want to export
suspect sentences.

3. Select sentences to export that contain the following:

• Terms that don't have a translation in the termbase

• Terms that have a translation that is not in the termbase

• All categories (all suspect sentences)

4. Use Browse to select an output file.

5. Select Export. The sentences are exported to the output file.

6. Open the output file and edit the sentences as required.

Note: In the text window in the QA Project, you can select from a drop-down list which
category of suspect sentences you want to highlight. You can navigate through the terms
by pressing [Tab] to go to the next term and [Shift]+[Tab] to go to the previous term.
To move from one suspect sentence to the next press [Ctrl]+[Tab].

Using filters when exporting
MultiTerm Extract uses filters in the export process when determining which terms to export.

This section explains the following tasks:

• Creating a new filter

• Editing a filter definition

• Removing a filter
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Creating filters

You can create filters to sort the terms you want to export.

Procedure

1. Access Tools > Filters from the menu bar.

Note: You can also access the New Filter dialog from the Export Wizard. Select Create
New Filter or Edit Filter on the Filters page.

2. In the Filters dialog, select New to open the New Filter dialog.

3. In the Name box, enter a name for the filter to create. The default name for the filter is
MyFilter.

4. Create a filter definition:

a. Select a box from the Field List and select Add to add it to the Constraints List.
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b. Specify a criterion to define how MultiTerm Extract should filter the selected box. If
the selected box is associated with an attribute picklist, select an item from the
Attribute Picklist. If the selected box is not associated with an attribute picklist,
use the Criterion box to enter a suitable criterion. The criterion you specify is
automatically added to the Constraints List. In the following screen shot, the filter
definition consists of one constraint. The box Validated is added to the Constraints
List and Yes is specified as the criterion. When this filter is active, MultiTerm Extract
will export validated terms only.

c. Repeat this process for each constraint to add to the filter definition. A filter
definition may consist of one or several constraints. The tree structure in the Field
List indicates whether a box applies to entry level, source language or target
language content. The level to which a box belongs determines whether the filter
constraint is valid for entry level, source language or target language content.

d. Specify the entry level boxes:

• Note: Enter a text string to filter on in the Note box. If you select <Empty>, and
choose NOT as the operator, MultiTerm Extract filters for all terms that contain
a note.

• Definition: Enter a text string to filter on in the Definition box. If you select
<Empty>, and chooseNOT as the operator, MultiTerm Extract filters for all terms
that contain a definition.

• Domain: Enter a domain label to filter on.

• Number of translations: Enter the greater than [>], less than [<] or equal [=]
sign and a value to indicate the number of translations. For example, if you
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specify < 10, MultiTerm Extract will filter for all terms with fewer than 10
translations.

• Created: Enter the date on which the entry was created. Use the greater than
[>], less than [<] or equal [=] signs to qualify the criterion.

• Modified: Enter the date on which the entry was modified. Use the greater than
[>], less than [<] or equal [=] signs to qualify the criterion.

e. Specify the source and target language boxes:

• Score: Enter the greater than [>], less than [<] or equal [=] sign and a value to
indicate the score. For example, if you specify a score of > 70, MultiTerm Extract
will filter for all terms with a score that is greater than 70. The score is largely
calculated using the frequency that a term appears in the document. High scores
indicate probable terms.

• Validated: From the Attribute Picklist, select Yes to include and No to exclude
validated terms.

• File name: Enter the name of the file on which you want to filter.

• Acronym: Enter the acronyms on which you want to filter; select Or to separate
them with a logical 'or'. You can enter the full form of the acronym if the
acronym is defined in the Acronym box in the Term properties window. If you
select <Empty>, and chooseNOT as the operator, MultiTerm Extract filters for all
terms that contain an acronym.

• Existing: Select Yes to include terms that already exist in the termbase and No
to exclude existing terms.

f. Specify filter constraints:

• Select Case sensitive for the text strings you enter as filter criteria to be
case-sensitive. For example, if you enter the text string ansi as a filter criteria
and select the Case sensitive option, MultiTerm Extract will filter on ansi but not
on Ansi or ANSI.

• Separate items on the Constraints List with a logical 'or' by selecting Or.

• Exclude specific content from the export by selecting Not to qualify the relevant
filter constraint.

5. When you have finished defining your filter, check that the information displayed in the
Constraints List is correct.

6. Select OK to confirm and to return to the Filters dialog.

The new filter is displayed on the list and will be available for selection during the export
process.

What to do next

To create another filter, select New. To return to your MultiTerm Extract project, select OK.
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Editing filters

You can edit filters at any time to update them.

Procedure

1. Access Tools > Filters from the menu bar.

Note: You can also access the New Filter dialog from the Export Wizard. To do this,
select Create New Filter or Edit Filter on the Filters page.

2. In the Filters dialog, select the filter definition to modify.

3. Select Edit to open the Edit Filter dialog.

4. Change the filter definition as required. Select OK to return to the Filters dialog. Select
OK again to return to your MultiTerm Extract project.

Removing filters

You can remove the filters which are no longer necessary.

Procedure

1. Access Tools > Filters from the menu bar.

2. In the Filters dialog, select the filter definition to remove, and then select Remove.

3. Select OK to return to your MultiTerm Extract project.
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Settings
This section includes information on defining settings and preferences for SDL Trados
projects.

The following areas are presented:

• Preferences

• Project settings

• File Format Settings

Preferences

Select File > Preferences from the menu bar to define your MultiTerm Extract project
preferences. The Preferences dialog opens.

1. Select the Remove non-validated terms before extracting check box to be asked if
MultiTerm Extract should remove any non-validated terms from the term candidate list.
This option applies when you process a project for a second or subsequent time within
the same session. Non-validated terms are added to the learning termbase for your
project.

2. Select the Open most recent project at startup check box to launch the last project
you worked on when you opened MultiTerm Extract.

3. Select the Ask for confirmation when exiting MultiTerm Extract check box to be
prompted to confirm that you want to exit the application.

4. Number of concordance sentences (on each page) determines how many
concordance examples are displayed in one Concordance window. The default is set to
10.

5. Select Reset to defaults to return to the MultiTerm Extract default preference settings.

6. Select OK when you are finished.
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Project settings

Select Project > Settings from the menu bar to open the Project Settings dialog box. Trados
Studio collects all the information about the term extraction process.

This section explains the tabs within the Project Settings dialog box. The tabs available
depend on the project type and include the following:

• Add/Remove Files

• Exclude

• Term Extraction

• Dictionary Compilation

• Translation

Add/Remove files tab

The Project Files list displays the files in the current Trados Studio project.

• To add more files to the project, select Browse.

• To remove files from the project, select the files to remove and click Remove. A
confirmation message is displayed. You can also remove the terms belonging to the
files from the project. Select Yes and the selected files are removed from the Project Files
list. If you choose to remove the terms as well, they are removed from the Termwindow.
Select No to return to the Project Settings dialog.
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Exclude tab

On the Exclude tab, select termbases and exclude lists for your project. Terms in the selected
termbases and exclude lists are not extracted from the files specified in your project
settings.

About this task

If you want to add extracted terms to an existing MultiTerm termbase, you exclude terms
from that termbase from the extraction process to avoid double entries and repeatedly
validating the same terms. An exclude list is a text file containing specific terms to not include
in the extraction process.

Procedure

1. Exclude extraction of terms from a termbase in your project:

a. Select Exclude termbase.

b. In the Choose Exclude Termbase dialog, select the termbase to exclude and select
OK.

c. In the Choose Language to Exclude dialog, select the language of the terms to
exclude. This will usually be the same language as the source language of your
project.

Note: If you select a remote termbase, select Remote Login to open the Server
Login dialog where you can specify MultiTerm Server computer and login details.

d. Select OK to return to the Project Settings dialog.

2. Set excluded lists:
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a. Select Exclude file to specify lists of terms to not include in the extraction process.
The Select dialog is displayed.

b. Browse to the exclude list and select Select to return to the Project Settings dialog.

Note:

• View the excluded terms by selecting View excluded terms.

• Remove an exclude list by selecting a file and selecting Remove.

Defining the learning settings

Trados Studio uses the learning termbase to collect all term candidates that you delete, and
thus reject, as term candidates during the term extraction process. The learning termbase
is updated each time you delete a term during term extraction; terms that exist in the
learning termbase are not extracted again. In this way, Trados Studioavoids displaying
unwanted terms in the Term window.

About this task

You can use the learning termbase in the current project and in subsequent projects as an
exclude termbase. Trados Studio does not extract any terms that exist in the exclude
termbase during term extraction.

Procedure

1. Select the Record discarded terms check box to choose a database that will store any
terms you reject.

2. Select Browse to select the database or to create a new one. In the Choose Learning
Termbase dialog:

a. Select the termbase from the Termbases list and select OK.

b. Select Settings to specify the termbase location.

Note: Specify the MultiTerm Server computer if you select a remote termbase.

c. Select New termbase to create a new learning termbase.

d. In the Create Learning Termbase dialog:

a. Enter the name of the termbase in the Termbase name box.

b. Select the languages you require from the Select languages list box.

c. Select Create to set up the new termbase.

3. Select Options to display the Learning Termbase Options dialog:
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• To update the learning termbase every time you delete a term candidate from a
project, select the appropriate option.

• To receive a confirmation message if entries are being added to the learning
termbase, choose the appropriate option.

4. Select OK to return to Project Settings.

Term Extraction tab

You can customize the following term extraction algorithm settings to fine tune the
extraction process.

• Minimum term length indicates the minimum number of words required to form a
term. The default setting is 1.

• Maximum term length indicates the maximum number of words that a term may
have. The default setting is 10.
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• Maximum number of extracted terms indicates the maximum number of terms that
Trados Studio will extract. The default setting is 100.

• Silence/noise ratio: The higher the silence ratio, the fewer term candidates are
extracted. However, these term candidates are generally of higher quality. The higher
the noise ratio, the more term candidates are extracted. However, it is likely that these
will include a number of lower quality candidates.

Dictionary Compilation tab

• In theMinimum word frequency box, specify the minimum number of times a term
and its translation must be shown in a text before being added to the term candidate list.
The default setting is 3.

• SelectMaximum word frequency to specify the maximum number of times a term and
its translation can appear in a text before being excluded from the term candidate list.
The default setting is 20.

• SelectMaximum number of translations to specify the maximum number of possible
translations that Trados Studio will extract for a given term. This option is active by
default and the default setting is 5.

• In theMinimum translation frequency box, specify the minimum number of times a
termmust be translated by its target in order for the target term to be added to the term
candidate list. The default setting is 3.

• In theMaximum translation frequency box, specify the maximum number of times a
term may be translated by its target term before the target term is excluded from the
term candidate list. The default setting is 20.

• Click Stopword Lists to set the language-specific list(s) containing articles, pronouns
and other items that are to be excluded from the extraction process.
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Translation tab

You can customize the following translation algorithm settings to fine tune the translation
process.

• Select the Search for new translations check box.

• SelectMaximum number of translations to set the maximum number of possible
translations that Trados Studio will extract for a given term. This option is active by
default and the default setting is 5.

• In theMinimum translation frequency box, specify the minimum number of times a
termmust be translated by its target term in order for the target term to be added to the
term candidate list. The default setting is 3.

• Click Stopword Lists to set the language-specific list(s) containing articles, pronouns
and other items that are to be excluded from the extraction process.

File format settings

To extract terms from HTML, SGML, XML, ASP or JSP files, you must specify a settings file
(*.ini) before starting the term extraction process.

MultiTerm Extract needs the settings file to interpret these files correctly and to distinguish
between tags and text. If you do not have a settings file, you must create one using TagEditor
or Translator's Workbench.

Note:MultiTerm Extract needs the settings file to interpret these files correctly and to
distinguish between tags and text. If you do not have a settings file, you must create one
using TagEditor or Translator's Workbench.
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Selecting a settings file

Procedure

1. Access Tools > File Format Settings from the menu bar.

Note: You can also access the File Format Settings dialog from the New Project Wizard.
On the Add files to this project page, select File Format Settings. In the File Format
Settings dialog, select a specific settings file for the current project.

SDL Trados provides default settings files for several tagged formats, including *.html,
*.htm, *.jsp, *.asp, *.aspx, *.sgml, *.sgm and *.xml files. The default settings files are
listed in the Settings File column.

2. In the File Format Settings dialog, under File Type, identify the file format for which you
want to specify a settings file, and then select in the corresponding cell in the Settings
File column. The relevant cell in the File Type column is highlighted and a Browse button
is displayed opposite in the Settings File column.

3. Select Browse to open the Choose Settings File dialog where you can browse to select
the settings file. Select Set to return to the File Format Settings dialog. The path to the
settings file is shown in the Settings File column.
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4. Select OK to confirm and to return to the main program window.

QA Statistics
After you have processed a QA Project, a QA report provides statistical information about
the terms in project files and existing terms in the MultiTerm termbase for the project.

The statistics are related to the quality of the project files or translated texts and the quality
of the MultiTerm termbase. In particular, the report contains a number of tables and pie
charts that are explained in the following section.
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Document quality

The table refers to source sentences containing terms that also exist in the project termbase.

• Number of sentences without terms: Number of source sentences that do not contain
any terms that are stored in the project termbase.

• Number of correct sentences: Number of correct source language sentences
containing terms that also exist in the project termbase. A 'correct' sentence is one
whose target language terms are identical to those in the termbase.

• Number of incorrect sentences: Number of incorrect source language sentences
containing terms that also exist in the project termbase. An 'incorrect' sentence is one
in which at least one of the target language terms is different to its equivalent in the
termbase.

• Total number of sentences: The total number of source language sentences.

• Occurrences of terms with a translation: Number of source language terms for which
the target language term is identical to the one in the termbase.

• Occurrences of terms without a translation: Number of source language terms for
which the target language term is different to its equivalent in the termbase.

• Occurrences of terms: Number of source language terms that exist in both the text
and the termbase.

Termbase quality

The information in this table shows the extent to which terms in the translated text match
the translations given in the project termbase.

• Terms which are always translated correctly: Number of source language terms
whose target language terms are identical to those in the project termbase.

• Terms which are never translated correctly: Number of source language terms whose
target language terms are never identical to those in the project termbase.

• Terms which are sometimes translated correctly: Number of source language terms
whose target language terms are sometimes identical and sometimes different to
those in the project termbase.

• Terms: The total number of source language terms.

Keyboard shortcuts
The following table shows the keyboard shortcuts for use with Trados Studio.

Keyboard Shortcut Action

Menus

[Ctrl]+[N] Creates a new project.

5MultiTerm Extract reference

75MultiTerm Extract Tools User Guide



Keyboard Shortcut Action

[Ctrl]+[O] Opens an existing project.

[Ctrl]+[W] Closes a project.

[Ctrl]+[S] Saves a project.

[Ctrl]+[A] Saves a project under a different name.

[Ctrl]+[E] Exports terms. In a QA Project this exports suspect sentences.

[Ctrl]+[Z] Undoes the last action.

[Ctrl]+[Y] Redoes the last action.

F7 Processes files.

Term Window

[Spacebar] Validates the current term candidate.

[Delete] Deletes the selected term from the term candidates list.

[F2] Opens a term in the source and/or target column for editing.

[Ctrl]+[Insert] Inserts a new translation of a source term in the target column
of the Term window.

Text Window

[Spacebar] Selects the term candidate or translation at the cursor.

[Delete] Deletes the current term if it is part of the term candidates list.

[Ctrl]+[Insert] If source sentence text is selected, this command adds selected
text in a source sentence as a new term. If target sentence text is
selected, this command adds selected text in a target sentence
as a new translation.

[F3] If some text is selected, Trados Studio carries out a concordance
search using this text.

[Tab] In the QA Project, goes to the next term.

[Shift]+[Tab] In the QA project, goes to the previous term.

[Ctrl]+[Tab] In the QA project, moves from one suspect sentence to the next.

[Alt]+[Enter] Displays the properties of the current term in the Term
properties window.

Concordance Window

[Spacebar] Selects the term candidate or translation at the cursor.

[Delete] Deletes the current term if it is part of the term candidates list.

[F3] If some text is selected Trados Studio carries out a concordance
search using this text.

[Ctrl]+[Insert] Adds selected text as new term.

[Shift]+[Tab] Goes to the previous term in the Concordance window.
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Keyboard Shortcut Action

[Tab] Goes to the next term in the Concordance window.

[Alt]+[Enter] Displays the properties of the current term in the Term
properties window.

Other Shortcuts

[Ctrl]+[Tab] Switches between internal frames in the Term, Term properties
and Concordance windows.
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MultiTerm includes open source or similar third-party software.

Crc32C.NET.signed
Version: 1.0.5

Vendor: Robert Važan

Copyright: Copyright (c) 2014-2020, Robert Važan

License type: BSD-3-Clause

License details: https://github.com/robertvazan/crc32c.net/blob/master/LICENSE

Microsoft.ApplicationInsights
Version: 2.12.1

Vendor: Microsoft

Copyright: Copyright (c) 2015 Microsoft

License type: MIT

License details: https://github.com/microsoft/ApplicationInsights-dotnet/blob/2.12.
1/LICENSE

CommandLineParser
Version: 1.9.71

Vendor: Giacomo Stelluti Scala

Copyright: Copyright (c) 2005 - 2013 Giacomo Stelluti Scala

License type: MIT

License details: https://github.com/commandlineparser/commandline/blob/v1.9.71.
2/doc/LICENSE

Microsoft.AspNet.WebApi.Client
Version: 5.2.7

Vendor: Microsoft

Copyright: ©Microsoft Corporation. All rights reserved.

License type: Apache 2.0

License details: https://github.com/aspnet/AspNetWebStack/blob/v3.2.7/LICENSE.txt

Microsoft.AspNetCore.SignalR.Client
Version: 1.1.0

Vendor: Microsoft

Copyright: Copyright (c) .NET Foundation and Contributors

License type: Apache 2.0

License details: https://github.com/aspnet/SignalR/blob/1.1.0/LICENSE.txt
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Microsoft.IdentityModel.Protocol.Extensions
Version: 1.0.4.403061554

Vendor: Microsoft

Copyright: Copyright (c) Microsoft Corporation

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/dev/LICENSE.txt

System.IdentityModel.Tokens.Jwt
Version: 6.11.1.0

Vendor: Microsoft

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/dev/LICENSE.txt

Microsoft.IdentityModel.Tokens
Version: 6.11.1.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/6.7.1/LICENSE.txt

YamlDotNet
Version: 8.1.1.0

Vendor: Antoine Aubry

Copyright: Copyright (c) Antoine Aubry and contributors 2008 - 2019

License type: MIT

License details: https://github.com/aaubry/YamlDotNet/blob/v8.1.2/LICENSE.txt

NETStandard.Library
Version: 2.0.3

Vendor: Microsoft

Copyright: Copyright (c) .NET Foundation and Contributors

License type: MIT

License details: https://github.com/dotnet/standard/blob/v2.0.3/LICENSE.TXT
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Autofac
Version: 4.8.1

Vendor: Autofac

Copyright: Copyright © 2015 Autofac Contributors

License type: MIT

License details: https://github.com/autofac/Autofac/blob/v4.8.1/LICENSE

HtmlAgilityPack
Version: 1.11.34.0

Vendor: ZZZ Projects

Copyright: Copyright © ZZZ Projects Inc.

License type: MIT

License details: https://github.com/zzzprojects/html-agility-pack/blob/v1.11.16/LICENSE

Xliff.OM
Version: 1.0.2

Vendor: RyanKi

Copyright: Copyright 2016 RyanKi

License type: MIT

License details: https://github.com/microsoft/XLIFF2-Object
-Model/blob/master/LICENSE.txt

murmurhash-signed
Version: 1.0.3.0

Vendor: Darren Kopp

Copyright: Copyright 2013 Darren Kopp

License type: Apache 2.0

License details: https://github.com/darrenkopp/murmurhash
-net/blob/master/LICENSE.md

System.IO.Abstractions
Version: 13.2.38.0

Vendor: Tatham Oddie

Copyright: Copyright © Tatham Oddie 2010

License type: MIT

License details: https://github.com/System-IO
-Abstractions/System.IO.Abstractions/blob/v4.2.17/LICENSE
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Flee
Version: 1.2.2

Vendor: Muhammet Parlak

Copyright: Copyright 2017 Muhammet Parlak

License type: L-GPL

License details: https://github.com/mparlak/Flee

PowerCollections
Version: 1.0.0.0

Vendor: Wintellect

Copyright: Copyright 2015 Wintellect

License type: EPL

License details: https://www.nuget.org/packages/Stakata.Wintellect.PowerCollections/1.0.
4/License

ANTLR 3 Runtime
Version: 3.1.3

Vendor: Terence Parr

Copyright: Copyright (c) 2011 The ANTLR Project

License type: BSD

License details: https://github.com/antlr/antlrcs/blob/master/LICENSE.txt

CachedImage
Version: 0.1.8

Vendor: Haridas Pachuveetil

Copyright: Copyright (c) 2014 Haridas Pachuveetil

License type: MIT

License details: https://github.com/floydpink/CachedImage/blob/main/LICENSE

Microsoft.AspNetCore.JsonPatch
Version: 5.0.7

Vendor: Microsoft

Copyright: ©Microsoft Corporation. All rights reserved.

License type: Apache 2.0

License details: https://github.com/dotnet/aspnetcore/blob/1.1.1/LICENSE.txt

Microsoft.Extensions.DependencyInjection.Abstractions
Version: 5.0.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: https://github.com/dotnet/extensions/blob/9bc79b2f25a3724376d7af
19617c33749a30ea3a/LICENSE.txt

Microsoft.Extensions.DependencyModel
Version: 2.0.4

Vendor: Microsoft

Copyright: Copyright (c) .NET Foundation and Contributors

License type: MIT

License details: https://github.com/dotnet/core-setup/blob/v2.0.4/LICENSE.TXT

Microsoft.IdentityModel.JsonWebTokens
Version: 6.11.0.0

Vendor: Microsoft

Copyright: Copyright (c) .NET Foundation and Contributors

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/5.6.0/LICENSE.txt

Microsoft.IdentityModel.Logging
Version: 6.11.1.0

Vendor: Microsoft

Copyright: Copyright (c) .NET Foundation and Contributors

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/5.6.0/LICENSE.txt

log4net
Version: 2.0.8

Vendor: The Apache Software Foundation

Copyright: Copyright 2004-2017 The Apache Software Foundation

License type: Apache 2.0

License details: https://github.com/apache/logging-log4net/blob/rel/2.0.8/LICENSE

Markdig.Signed
Version: 0.18.3

Vendor: Alexandre Mutel

Copyright: Copyright (c) 2018-2019, Alexandre Mutel

License type: BSD-2-Clause

License details: https://github.com/xoofx/markdig/blob/0.18.3/license.txt
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NLog
Version: 4.6.7

Vendor: Jarek Kowalski, Kim Christensen, Julian Verdurmen

Copyright: Copyright (c) 2004-2020 NLog Project - https://nlog-project.org/

License type: BSD-3-Clause

License details: https://github.com/NLog/NLog/blob/v4.6.7/LICENSE.txt

SharpZipLib
Version: 1.2.0

Vendor: ICSharpCode

Copyright: Copyright © 2000-2018 SharpZipLib Contributors

License type: MIT

License details: https://github.com/icsharpcode/SharpZipLib/blob/v1.2.0/LICENSE.txt

System.Data.SQLite
Version: 1.0.111.0

Vendor: SQLite

Copyright: Public domain

License type: Public domain

License details: https://www.sqlite.org/copyright.html

ICU
Version: 59.1.15.0

Vendor: SIL International

Copyright: Copyright (c) 2016-2017 SIL International

License type: ICU

License details: https://github.com/unicode-org/icu/blob/release-59-1/icu4c/LICENSE

DocumentFormat.OpenXml
Version: 2.8.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/OfficeDev/Open-XML-SDK/blob/v2.8.1/LICENSE

System.ValueTuple
Version: 4.5.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT
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License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Collections.Immutable
Version: 5.0.0

Vendor: Microsoft

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT

System.Reactive
Version: 4.3.2

Vendor: .NET Foundation and Contributors

Copyright: Copyright (c) .NET Foundation and Contributors.

License type: MIT

License details: https://github.com/dotnet/reactive/blob/rxnet-v4.3.2/LICENSE

Newtonsoft.Json
Version: 12.0.2

Vendor: James Newton-King

Copyright: Copyright © James Newton-King 2008

License type: MIT

License details: https://github.com/JamesNK/Newtonsoft.Json/blob/12.0.2/LICENSE.md

SmartThreadPool
Version: 2.2.6.0

Vendor: Ami Bar

Copyright: Copyright © Ami Bar

License type: MS-PL

License details: https://github.com/amibar/SmartThreadPool/blob/v2.2.6/LICENSE

SimpleInjector
Version: 5.3.0.0

Vendor: Simple Injector Contributors

Copyright: Simple Injector Contributors 2010 - 2020

License type: MIT

License details: https://github.com/simpleinjector/SimpleInjector/blob/v4.9/LICENSE

Microsoft.Xaml.Behaviors.Wpf
Version: 1.1.19.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: https://github.com/microsoft/XamlBehaviorsWpf/blob/v1.1.19/LICENSE

Microsoft.Extensions.Logging.Abstractions
Version: 5.0.0.0

Vendor: Microsoft

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/extensions/blob/2.2.0/LICENSE.txt

MaterialDesignThemes.MahApps
Version: 0.0.11

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MS-PL

License details: https://www.nuget.org/packages/MaterialDesignThemes.MahApps/0.0.
11

OpenXmlPowerTools
Version: 4.5.3.0

Vendor: Eric White

Copyright: Copyright © Eric White

License type: MIT

License details: https://github.com/OfficeDev/Open-Xml-PowerTools/blob/vNext/LICENSE

WatiN
Version: 2.1.0.0

Vendor: Jeroen van Menen

Copyright: Copyright © Jeroen van Menen

License type: Apache 2.0

License details: https://www.nuget.org/packages/WatiN/2.1.0

System.Threading.Tasks.Extensions
Version: 4.5.4.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT
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System.Security.Cryptography.X509Certificate
Version: 4.3.2.0

Vendor: Microsoft

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Security.Cryptography.Algorithms
Version: 4.3.1.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Reflection.TypeExtensions
Version: 4.7.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Linq.Queryable
Version: 4.3.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.IO.FileSystem.Primitives
Version: 4.3.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Memory
Version: 4.5.4.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT
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License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Numerics.Vectors
Version: 4.5.0.0

Vendor: Microsoft

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Buffers
Version: 4.5.1.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Runtime.CompilerServices.Unsafe
Version: 5.0.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

SharpCompress
Version: 0.26.0

Vendor: Adam Hathcock

Copyright: Adam Hathcock

License type: MIT

License details: https://github.com/adamhathcock/sharpcompress/blob/0.26/LICENSE.txt

Sdl.MultiSelectCombobox
Version: 1.0.17

Vendor: RWS

Copyright: Copyright © RWS

License type: Apache 2.0

License details: https://github.com/sdl/Multiselect-ComboBox/blob/master/LICENSE

Microsoft.WindowsAPICodePack.Shell
Version: 1.1.0.0

Vendor: NanaLich

Copyright:
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License type:

License details:

icu.net
Version: 2.7.1.0

Vendor: SIL International

Copyright: Copyright © 2007-2019 SIL International

License type: MIT

License details: https://github.com/sillsdev/icu-dotnet/blob/v2.5.4/LICENSE

Microsoft.Extensions.Http
Version: 5.0.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: Apache 2.0

License details: https://github.com/aspnet/HttpClientFactory/blob/2.2.0/LICENSE.txt

MahApps.Metro
Version: 1.5.0

Vendor: Jan Karger, Dennis Daume, Brendan Forster, Paul Jenkins, Jake Ginnivan, Alex
Mitchell

Copyright: Copyright © 2021 .NET Foundation and Contributors. All rights reserved.

License type: MIT

License details: https://github.com/MahApps/MahApps.Metro/blob/1.5.0/LICENSE

NQuant
Version: 1.0.3

Vendor: Matt Wrock

Copyright: Copyright Matt Wrock 2011

License type: Apache 2.0

License details: https://github.com/philjones/nquant/blob/master/License.txt
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